
  
  

PN 101-8515 A2 
 TECHNICAL NOTE 

Copy Number Analysis Using Biomark HD 
with the 96.96 IFC and TaqMan CNV Assays 
 

Introduction  
Copy number variations (CNVs) are inherited or 
acquired (de novo) structural changes in the natural 
complement of DNA segments within the genome, 
resulting in a loss (deletion) or gain (duplication) of 
nucleotides. CNVs can vary in size from a few bases 
to a complete gene or chromosome, and they 
represent an important genetic variation component 
that can have an advantageous, deleterious, or 
neutral phenotypic outcome. Research applications 
that analyze CNV biomarkers include disease 
association studies (for example autoimmunity), 
pharmacogenomics, and cancer research. 
Additionally, CNV analysis is routinely employed 
within the crop and animal sciences to guide the 
selection of traits that affect nutritional quality or yield, 
promote disease resistance, and enable adaptation to 
environmental conditions.  

In this technical note, we describe an analysis method 
that may be used in a copy number workflow. This 
method includes the 96.96 Dynamic Array™ IFC for 
Gene Expression and Applied Biosystems® TaqMan® 
assays on Biomark™ HD. CopyCount-CNV™ software 
may be used for subsequent analysis of the data 
generated, as shown through the study conducted to 
demonstrate proof of principle. Although the 96.96 
Dynamic Array integrated fluidic circuit (IFC) enables 
analysis of up to 96 individual research samples, it is 
advisable to run samples in replicate when performing 
CNV analysis to achieve the best results. The total 
number of samples analyzed with the 96.96 Dynamic 
Array IFC depends on the number of replicates. For 
example, 24 samples can be analyzed when running 
replicates of 4, and 32 samples can be analyzed with 
replicates of 3.  

The workflow for CNV analysis on Biomark HD 
described here is a guideline. Optimization in your 
laboratory is recommended.  

Study Design 
To assess workflow and performance of the protocol, 
48 samples that include one duplicate sample and 
one no template control (NTC) were run with two 
TaqMan assays and 8 replicates per assay. Samples 
were sourced from the NIGMS Human Genetic Cell 
Repository at the Coriell Institute for Medical Research 
(see Table 1 for repository ID numbers) and an 
external laboratory, which extracted and processed 
the samples in accordance with the protocol 
described in this technical note. The assays were 
sourced from Thermo Fisher Scientific (see Table 2).  

Table 1. Study samples obtained from Coriell Institute 

Repository ID  

NA17104 NA17128 

NA17107 NA17194 

NA17109 NA17227 

NA17117  

 

Table 2. Assays used to conduct the copy number analysis 
study 

Assay ID Gene 
Target 

Assay Type 

Hs00010001_cn CYP2D6, 
exon 9 

TaqMan Copy Number 

Hs03297761_s1 RPPH1 TaqMan Gene Expression 

Raw fluorescence data collected from Biomark HD 
was processed by Fluidigm with an alternative 
commercially available software package to establish 
a reference copy number.  

The same data was subsequently blinded, parsed into 
separate files (.csv) by assay, and provided to DNA 
Software along with the following information to 
facilitate configuration of the CopyCount-CNV 
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software: PCR volume, amplicon length, primer and 
probe concentrations, dye type, and chemistry format. 

Analysis was conducted by DNA Software using 
CopyCount-CNV in uncalibrated mode. The software 
generated a copy number result for each sample-
assay combination, as well as metrics for the CV of 
ratio, Z-score, and confidence value. Results were 
subsequently unblinded by Fluidigm to compare the 
observed results with the predicted copy number. 

Results and Discussion 
CopyCount-CNV software generated copy number 
results that were 100% concordant with the results of 
the alternate software product for this dataset of 47 
sample-assay pairs (see Figure 1). The one sample 
represented twice in the sample set produced the 
same copy number result using either software 
package. While the results concordance was high, the 
CopyCount-CNV data had a smaller standard 
deviation and greater separation between bins used 
to define copy number (see Figure 2). This indicates 
results generated with CopyCount-CNV have greater 
precision.  

Conclusions 
Both software packages generated the same copy 
number call for 100% of the samples as part of a blind 
test. As a result of the tighter standard deviation, 
CopyCount-CNV had more separation between bins 
than the alternate software package used for 
comparison. For high-throughput applications, it is 
expected that CopyCount-CNV would make fewer 
false copy number determinations relative to the 
comparative software used to conduct this study. 

 

Figure 1. Copy number results for CYP2D6 for the 47 study 
samples, as determined by CopyCount-CNV and a 
commercially available alternative software package 

 
CopyCount-CNV Alternative software product 

  

Standard deviation (SD)  0.1676    0.2037 

Bin characterization  

CN 1: Max CN=1.25   2.64 SD separation CN 1: Max CN=1.21 2.01 SD separation 

CN 2: Min CN=1.70 CN 2: Min CN=1.62 

CN 2: Max CN=2.27 2.44 SD separation CN 2: Max CN=2.27 1.68 SD separation 

CN 3: Min CN=2.68 CN 3: Min CN=2.60 

Arrows indicate the same sample generated an ambiguous result for both software packages. 

Figure 2. Comparison of the standard deviation and bin characterization parameters for the two software packages  
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Materials 

Required Reagents 

• 2X Assay Loading Reagent  
(Fluidigm PN 85000736, part of kit PN 100-7611) 

• 20X Fast GT Sample Loading Reagent  
(Fluidigm 100-3065, part of kit PN 100-7606) 

• TaqMan GTXpress™ Master Mix (2X)  
(Thermo Fisher Scientific PN 4403311) 

• TaqMan PreAmp Master Mix (2X)  
(Thermo Fisher Scientific PN 4391128) 

• TaqMan CNV Target Assays with FAM™ MGB 
probe (Thermo Fisher Scientific) 

• TaqMan CNV Reference Assay with FAM MGB 
probe (Thermo Fisher Scientific) 

Do not use a reference assay labeled with VIC® dye. 

• DNA Suspension Buffer (10 mM Tris, 0.1 mM 
EDTA, pH 8.0) (Teknova PN T0221, 1 mL) 

• PCR-certified water 

• Human gDNA samples 

Required Consumables 

• 96.96 Dynamic Array IFC for Gene Expression 
(Fluidigm PN BMK-M-96.96) 

• Control Line Fluid for 96.96 IFCs  
(Fluidigm PN 89000021) 

• 1.5 mL Eppendorf® microtubes 

• 8-well PCR tube strips 

• 96-well PCR plates and sealing films 

Required Equipment 

• Biomark HD system 

NOTE The IFC run requires a customized thermal 
protocol. See Appendix A for custom protocol 
parameters. 

• Juno™ system or IFC Controller HX 

• HX Interface Plate (Fluidigm PN 101-6116), if using 
Juno 

• Pipettes (single- and multichannel) and 
appropriate low-retention filter tips 

• Vortexer 

• Two centrifuges: one for microtubes, one for 
96­well PCR plates 

• Standard thermal cycler [if using specific target 
amplification (STA)] 

Best Practices 
For the overall success of the protocol, we 
recommend the following best practices. 

• Avoid creating bubbles while vortexing reagents 
and when transferring reagents to the IFC.  

• Vortex gently (low speed) but thoroughly (at 
least 5 sec) to ensure all reagents and reagent 
mixes are homogeneous.  

• After vortexing, centrifuge to collect all mixes 
at the bottoms of the wells before pipetting 
into the IFC inlets. Failure to do so may result 
in a decrease in data quality. 

• Check the source plate or tube for bubbles 
before pipetting.  

• Check pipette tips for air gaps while pipetting. 

• Pipet reagents slowly and carefully to transfer 
entire volumes and to minimize bubbles.  

• To avoid creating bubbles in the IFC inlets, 
pipet into the inlets at an angle and do not go 
past the first stop on the pipette. If a bubble is 
introduced, ensure that it floats to the top of 
the inlet. 

• If necessary, remove bubbles from an IFC inlet 
by removing the contents of the inlet by 
pipette and then carefully re-pipetting the 
contents into the inlet. 

• Unless otherwise specified, thaw reagents at 
room temperature (15–30 °C), and then use them 
at room temperature.  

• Mix and centrifuge reagents as directed.  

• For better traceability, assemble DNA samples in 
a 96-well PCR plate and record in a sample map. 

• Place the sample mixes on ice when not in use. 

• To reduce the number of pipetting steps, we 
recommend first aliquoting reagents into an 8-well 
PCR tube strip to enable transfer into a 96-well 
plate using an 8-channel pipette. 
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• Inspect the IFC for any signs of visible damage 
before use. Ensure that the barcode label is intact 
and the IFC surfaces are clear of particulates. 

• During use, take care to avoid the introduction 
of particulates, reagents, and fluids to the 
surface of the IFC.  

• Use clear tape to remove any particulates from 
the IFC surface. 

Protocol  
For detailed instructions on instrument and software 
operation, see the appropriate instrument user guide.  

IMPORTANT  

• Before using reagents, read and understand the 
detailed instructions and safety guidelines in this 
document. For complete safety information, see 
Appendix C. 

• Ensure that all equipment is turned on and 
operational at least 30 min before use. 

• Generate sample mix and assay mix plate maps in 
advance to facilitate reagent deliveries and maintain 
traceability throughout the protocol. 

Preamplify the Samples Using STA 

Specific target amplification (STA) is recommended to 
ensure abundance of each CNV target or reference 
prior to distribution of sample within the IFC.  

IMPORTANT Use only Applied Biosystems TaqMan 
Copy Number assays at 20X concentration. 

1 Vortex and centrifuge all reagents. 

2 Denature all genomic DNA samples at 98 °C for 
5 min followed by snap cooling on ice for 2 min. 

3 Label a 1.5 mL microcentrifuge tube 0.2X Pooled 
Assays and combine the 20X TaqMan assays and 
DNA Suspension Buffer to prepare a primer pool 
mix, where each primer is at a final concentration of 
0.2X. See the example in Table 3. 

4 Add DNA Suspension Buffer to bring final volume 
to 400 µL. This will be enough for STA of at least 
192 samples. 

Table 3. Example primer pool mix. This example shows 
the volumes needed for four assays. 

Component Vol. per  
Assay  

(µL)* 

Vol. in .X 
Primer Pool 

(µL)* 

Four X TaqMan assays   

DNA Suspension Buffer 
(Teknova PN T) 

—  

Total —  

* Includes overage 

5 Prepare the preamplification mix in a 1.5 mL 
microcentrifuge tube by combining the 
components in Table 4. 

Table 4. Preamplification mix 

Component Vol. per  
Reaction 

(µL)* 

Vol. for  
Samples (µL)* 

n= reactions 

TaqMan PreAmp 
Master Mix (X)  

.  

Pooled assay mix (.X) .  

Total .  

* Includes overage 

6 Transfer 54 µL of the preamplification mix into 
each well of the strip. 

7 Using an 8-channel pipette, transfer 3.75 µL of 
preamplification pre-mix to each well of a 96-well 
plate. For 48 samples, fill only 48 wells. For 96 
samples, fill the entire plate.  

8 Using an 8-channel pipette, transfer 1.25 µL of 
genomic DNA to each well, to bring the total 
volume to 5 µL.  

9 Seal the plate, vortex briefly, and then centrifuge 
at 2,000 x g for 1 min. 
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10 Place the plate in a standard thermal cycler and 
cycle using the following thermal protocol: 

Temperature Time Cycle  

95 °C 10 min Hold  

95 °C 15 sec Denaturation 
15 
cycles* 60 °C 4 min Annealing/ 

extension 

4 °C ∞ Hold  

* Recommended starting point (within a range of 10–20 
cycles). The appropriate number of cycles may need to be 
determined empirically because sample sets may vary with 
respect to sample amount and quality. 

11 After cycling, dilute the reaction 1:5 by adding 
20 µL of DNA Suspension Buffer to the 
preamplification product. 

Prime the IFC 

For detailed instructions about injecting Control Line 
Fluid, see the Control Line Fluid Loading Procedure 
(PN 68000132). 

IMPORTANT  
• Use the GE 96.96 IFC within 24 hr of opening the 

package. 
• Use only 96.96 syringes with 150 µL of Control Line 

Fluid. 
• Do not evacuate air from syringes prior to injecting 

Control Line Fluid. 
• Avoid bending the syringe tip. Be careful when 

removing the syringe cap to prevent drips. 
• Avoid getting Control Line Fluid on the exterior of 

the IFC or in the inlets because this makes the IFC 
unusable. If this occurs, use a new IFC. 

1 Turn on the Juno instrument or IFC Controller HX, if 
necessary. Initialization takes approximately 5 min. 

2 If using Juno, ensure that the HX Interface Plate is 
installed in the instrument. 

3 Inject Control Line Fluid into each accumulator on 
the IFC (see Figure 3). Use the entire contents of 
one syringe in each accumulator. 

 

 

 

 

 

Control Line 
Fluid, 150 µL 

Figure 3. Accumulators on the GE 96.96 IFC 

4 Place the IFC into the controller: 

• Juno: Tap OPEN to open the instrument tray 
and align the notched corner of the IFC to the 
white notch on the tray. Tap LOAD. 

• IFC Controller HX: Press EJECT to open the 
instrument tray and align the notched corner 
of the IFC to the A1 mark. Press Load Chip.  

5 Run the prime script: 

• Juno: Tap Prime 96.96 GE and tap Run. 

• IFC Controller HX: Select Prime (136x) and 
press Run Script. 

Priming the IFC takes approximately 20 min. During 
that time, prepare the assays and samples.  

IMPORTANT Load the IFC within 60 min of 
completing the Prime script. 

Prepare 10X TaqMan Assays 

IMPORTANT Use only Applied Biosystems TaqMan 
Copy Number assays at 20X concentration. 

1 Allow the 2X Assay Loading Reagent to thaw at 
room temperature before use. 

2 Briefly vortex and centrifuge reagents before use. 

3 Label a new 96 well plate 10X Assays. 

4 In each well, prepare the assay mixes using 
volumes shown in Table 5 (sufficient volume to 
include four replicates per assay). Volumes can be 
scaled to include more replicates as necessary. 
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Table 5. Assay mix for each 20X CNV assay. Each 20X 
CNV assay will be replicated four times in the IFC. 

Component Vol. per 
 Inlet (µL)* 

Vol. for  
Replicates (µL) 

n= for overage 

X TaqMan CNV assay   

X Assay Loading Reagent    

Total   

* Includes overage 

5 Seal the 10X Assay plate well using an adhesive 
film, and then vortex to mix and centrifuge. 

Prepare Sample Mixes 

1 Thaw all reagents to room temperature. Ensure 
that the 20X GT Fast Sample Loading Reagent is 
at room temperature before use. 

2 Briefly vortex and centrifuge reagents before use. 

3 In a DNA-free hood, prepare the sample pre-mix 
in a 1.5 mL sterile tube using volumes shown in 
Table 6 (sufficient volume to process 96 individual 
samples).  

Table 6. Sample pre-mix 

Component Vol. per 
 Inlet (µL)* 

Sample Pre-Mix 
for One . 

IFC (µL)* 

PCR-certified water  . . 

TaqMan GTXpress 
Master Mix  

  

X GE Sample 
Loading Reagent 

.  

Total . . 

* Includes overage 

4 Transfer 68 µL of sample pre-mix into each well of 
8-well PCR tube strip.  

5 Dispense the sample pre-mix and add the DNA 
sample as shown in Table 7. Use an 8-channel 
pipette to transfer sample pre-mix from the tube 
strip into each well of a 96-well PCR plate.  

Avoid creating bubbles. Remove the sample pre-
mix plate from the DNA-free hood, and then add 
diluted, preamplified genomic DNA to each 
aliquot of sample pre-mix. 

Assign at least 1 well as NTC (no template control). 
Do not add genomic DNA to this well. Instead, 
add 3.33 µL of PCR-certified water. 

Table 7. Sample mix 

Component Vol. per  
Well (µL)* 

Sample pre-mix (see Table ) . 

Diluted, preamplified genomic DNA  . 

Total . 

* Includes overage 

6 Seal the plate well using an adhesive film. 

7 Mix the reactions by briefly vortexing, and then 
centrifuge. 

Load the IFC 

IMPORTANT  

• Avoid creating bubbles (see Best Practices on page 3). 
• Note the IFC orientation based on the A1 corner 

before you start pipetting. 
• Each assay will be replicated four times, so be sure 

to dispense each CNV 10X assay mix into four 
separate inlets.  

1 Turn on the Biomark HD system (computer and 
instrument), if necessary, and launch the Data 
Collection software to allow the instrument to start 
up and the camera to cool to the appropriate 
temperature. Temperature stabilization takes up 
to 20 min. 

2 Ensure that the 10X assay and sample mix plates 
have been vortexed and centrifuged within 30 min 
of use. Repeat the vortex and centrifuge process if 
the plates are unused for >30 min.  

3 When the prime script is complete, remove the 
primed IFC from the controller. 
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4 Pipet 5 µL of each 10X assay mix into the assay 
inlets of the IFC. 

 

5 Pipet 5 µL of each sample mix into the sample 
inlets of the IFC. 

 

6 Place the IFC into the controller and run the load 
mix script: 

• Juno: Tap Load Mix 96.96 GE, and then tap Run. 

• IFC Controller HX: Select Load Mix (136x) and 
press Run Script. 

Loading the IFC takes approximately 90 min.  

7 After loading is complete, eject the IFC from the 
controller and collect real-time PCR data on 
Biomark HD. 

IMPORTANT Start the IFC run on Biomark HD 
immediately after completing the Load Mix script. 

Collect Real-Time PCR Data on 
Biomark HD 

Transfer the loaded IFC from the controller to the 
Biomark HD and collect real-time PCR data. 

IMPORTANT The IFC run requires a customized 
thermal protocol. See Appendix A for instructions. 

1 Remove and discard the protective film from the 
bottom of the IFC. 

2 Use clear tape to remove any dust particles or 
debris from the IFC surface.  

3 If necessary, double-click the Data Collection 
icon on the desktop of the Biomark HD system 
computer to launch the software. 

4 Click Start a New Run.  

5 Confirm that the camera status indicator at the 
bottom of the window is green. 

6 Place the IFC on the instrument tray, aligning the 
notched A1 corner on the IFC with the A1 on the 
tray, and click Load. 

7 Complete the Chip Barcode and Type section: 

a Verify IFC barcode and IFC type. 

b Choose project settings (if applicable) and 
click Next.  

8 Complete the Chip Run section by selecting either 
a new or a pre-defined run. 

9 Complete the Chip Run Name and Location 
section: 

a Enter a run name or select the checkbox to 
use the IFC barcode as the run name. 

b  Select a file storage location for a new IFC run 
or browse to select a pre-defined run file and 
click Next.  
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10 Complete the Application, Reference and Probes 
section and then click Next. 

For… Select… 

Application Gene Expression 

Passive reference ROX 

Assay Single Probe 

Probes FAM-MGB 

11 Complete the Thermal Protocol section: 

a Browse to and select the thermal protocol:  
GE 96x96 Standard GTXpress v1.pcl 

b Confirm that Auto Exposure is selected and 
click Next.  

12 Verify the IFC run information and click Start Run. 

The IFC run takes approximately 2 hr. 

Analyze the Data 

After the run is complete, process your data using the 
Real-Time PCR Analysis software, followed by analysis 
using software that specializes in copy number variant 
determination, such as CopyCount-CNV software. 

Appendix A: Customize the 
Thermal Protocol 
For detailed instructions for using the Protocol Editor, 
see the Biomark HD Data Collection User Guide 
(PN 100-2451). 

1 Start the Biomark HD Data Collection software. 

2 Select Tools > Protocol Editor. 

3 In the Protocol Editor, select File > Open to 
browse to and open the protocol GE 96x96 
Standard v2.pcl. 

4 Make the following changes: 

a Remove the UNG slice. 

b Change the Duration for the Hot Start slice to 
20 sec. 

Table 8. Custom protocol parameters 

Temp. Time Cycles Description  

50 °C 2 min 

1 Thermal mix 70 °C 30 min 

25 °C 10 min 

96.5 °C 20 sec 1 Hot start 

96 °C 15 sec 
40 PCR 

Denaturation 

60 °C 60 sec Annealing 

 

5 Change the name in the title bar to: 
 GE 96x96 Standard GTXpress v1 

 

6 Select File > Save As and save the protocol with 
the name: GE 96x96 Standard GTXpress v1.pcl 
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Appendix B: Related 
Documents  
Go to fluidigm.com to download these related 
documents. 

Title Part Number 

Control Line Fluid Loading Procedure 68000132 

IFC Controller MX and  
IFC Controller HX User Guide 

68000112 

Juno System User Guide 100-7070 

Biomark HD Data Collection User 
Guide 

100-2451 

Real-Time PCR Analysis User Guide 68000088 

CopyCount-CNV user guide  
(for software v2.1.9.2 or later) 

NOTE This document is available for 
download from fluidigm.com on the 
product page for CopyCount-CNV 
(Fluidigm PN 101-7966). 

— 

Appendix C: Safety 

General Safety 

In addition to your site-specific safety requirements, 
Fluidigm recommends the following general safety 
guidelines in all laboratory and manufacturing areas: 

• Use the appropriate personal protective 
equipment (PPE): safety glasses, fully enclosed 
shoes, lab coats, and gloves, according to your 
laboratory safety practices. 

• Know the locations of all safety equipment (fire 
extinguishers, spill kits, eyewashes/showers, 
first-aid kits, safety data sheets, etc.), emergency 
exit locations, and emergency/injury reporting 
procedures. 

• Do not eat, drink, or smoke in lab areas. 

• Maintain clean work areas. 

• Wash hands before leaving the lab. 

Instrument Safety 

For complete instrument safety information, including 
a full list of the symbols on the instrument, refer to the 
appropriate instrument user guide (see Appendix B). 

WARNING BIOHAZARD. If you are putting 
biohazardous material on the instrument, use 
appropriate personal protective equipment 
and adhere to Biosafety in Microbiological 
and Biomedical Laboratories (BMBL), a 
publication from the Centers for Disease 
Control and Prevention, and to your lab's 
safety protocol to limit biohazard risks. If 
biohazardous materials are used, properly 
label the equipment as a biohazard. For more 
information, see the BMBL guidelines online 
at cdc.gov/biosafety/publications/index.htm. 

Chemical Safety 

The responsible individuals must take the necessary 
precautions to ensure that the surrounding workplace 
is safe and that instrument operators are not exposed 
to hazardous levels of toxic substances. When 
working with any chemicals, refer to the applicable 
safety data sheets (SDSs) provided by the 
manufacturer or supplier. 

Disposal of Products 

Used IFCs should be handled and disposed of in 
accordance with federal, state, regional, and local 
laws for hazardous waste management and disposal. 

 

 

 

http://www.fluidigm.com/
http://www.fluidigm.com/
http://cdc.gov/biosafety/publications/index.htm


  
  

Appendix D: Instrument Software Requirements and 
Ordering Information 
Fluidigm Instrument and Software 
Requirements 

Operation Instruments Software Version 

IFC loading 
and PCR 

Juno v3.11.1 or later 

IFC Controller HX v2.8 or later 

Imaging  Biomark HD 
 

v4.2.2 or later 
with customized 
thermal protocol 

Data 
analysis 

— Real-Time PCR 
Analysis v4.5.1 or 
later 

 

Recommended Third-Party Software  

Operation Software Version 

Copy number 
analysis 

CopyCount-CNV 2.1.9.2 or later 

NOTE CopyCount-CNV was 
developed by DNA Software, and 
is available for purchase through 
Fluidigm for use with Biomark HD. 

 

Ordering Information 

Vendor Name Part Number 

IFC and Control Line Fluid 

Fluidigm 96.96 Dynamic Array IFC for 
Gene Expression 

BMK-M-96.96 

Fluidigm Control Line Fluid Kit—96.96 89000021 

Fluidigm reagents  

Fluidigm 2X Assay Loading Reagent—
5 Tubes 

100-7611 

Fluidigm 20X Fast GT Sample 
Loading Reagent—5 Tubes 

100-7606 

Third-party reagents 

Thermo 
Fisher 
Scientific 

TaqMan GTXpress Master Mix 
(2X) 

4403311 

Thermo 
Fisher 
Scientific 

TaqMan PreAmp Master Mix 
(2X) 

4391128 

Thermo 
Fisher 
Scientific 

TaqMan CNV Target Assays 
with FAM-MGB probe 

— 

Thermo 
Fisher 
Scientific 

TaqMan CNV Reference 
Assay with FAM-MGB probe 

— 

Teknova DNA Suspension Buffer T0221 

Major 
laboratory 
supplier 

PCR-certified water — 
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